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This symbol, found on your product or on its packaging, indicates that this 

product should not be treated as household waste when you wish to dispose 

of it. Instead, it should be handed over to an applicable collection point for the 

recycling of electrical and electronic equipment. By ensuring this product is 

disposed of correctly, you will help prevent potential negative consequences to the 

environment and human health, which could otherwise be caused by inappropriate disposal 

of this product. The recycling of materials will help to conserve natural resources. For more 

detailed information about the recycling of this product, please contact your local city 

office, household waste disposal service or the retail store where you purchased this 

product. 

 

※ This equipment obtained certification by using 1.5M serial cable. 
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 1 Overview 

 Overview 

PBH-101 is a programmable device for industrial network communication. You can build 

various systems which are based on network using PBH-101 with many kinds of devices 

such as a personal computer. 

We provide a self-development programming language, which is called PHPoC, for 

programing PBH-101. This language is easy to use and compatible with PHP which is 

widely used script language. 

 PHPoC is basically compatible with PHP but those languages are not the same 

because of restrictions about embedded system. Please refer to the “PHPoC 

Language Reference Manual” and “PHPoC vs PHP” for detailed information. 

 Features 

 Provides Self-Development PHPoC Interpreter 

 Provides simple development environment via USB 

 Provides serial port with RS232/RS422/RS485 interface 

 Provides 10/100Mbit Ethernet 

 Provides IEEE802.11b/g Wireless LAN 

 Provides development tool for Windows 
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 Specification 

Power 
Input DC 5V (±0.5V) 

Current about 235㎃ (without USB WLAN adapter) 

Dimension 158㎜ x 90㎜ x 24㎜ 

Weight about 347g (without USB WLAN adapter) 

Interfaces 

Serial 
1 x RS232/RS422/RS485 

(Baud Rate: 1,200bps ~ 230,400bps) 

Network 

10 Base-T / 100 Base-TX Ethernet 

Auto MDI/MDIX (cable auto-sensing) 

IEEE802.11b/g 

(require Ralink RT3070/5370 chipset WLAN adapter) 

USB 
USB Host – for WLAN adapter 

USB Device – for PC 

Firmware PHPoC Interpreter 

Temperature 
Storage 

/Operating 
-40 ~ 85℃ 

Approval KC, CE, FCC 

Environment RoHS Compliant 

Software PHPoC Debugger 

Table 1-1 specification 
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 Dimension 

 

Figure 1-1 dimension 

 Dimensions may vary according to a method of measurement. 
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 Interface 

1.5.1 Panel Layout 

 

Figure 1-2 panel layout 

① LED PWR, STS, A~H 

② USB device port (Setup): PC connection, DC 5V power supply 

③ Ethernet port: 10/100M 

④ Serial port: RS232 / RS422 / RS485 

⑤ USB host port: USB WLAN adapter connection 

⑥ Power: DC 5V 

⑦ Function button (Func) 
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1.5.2 LED 

LED Name Action 

Power LED PWR turned ON with stable power supply 

Status LED STS 

running PHP 

> repeat On and Off in every second 

not running PHP 

> briefly blinks 1 time at a time 

User-defined LED A ~ H follows definition on user script 

Table 1-2 LED 

1.5.3 USB Device Port for connection with PC 

The USB device port is to connect with PC. You can access to products via development 

tool with connecting USB cable to this port. However, PBH-101 may not work properly in 

case of supplying power via this port only due to insufficient current. 

1.5.4 Function Button (Func) 

The function button is used for changing mode to button setup mode. 

1.5.5 Supplying Power 

 DC 5V Input 

This port is the main input port for supplying power. Specification is as follows: 

 

Figure 1-3 specification of power port 

 USB Device port (Micro USB) 

This port can be a sub input port for supplying power. 
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1.5.6 USB Host Port for Connection with a WLAN adapter 

PBH-101 provides a USB host port for an USB WLAN adapter. You can connect your 

product to Wireless LAN by connecting a WLAN adapter to this port. Note that you cannot 

use Ethernet (Wired LAN) while using this port. 

 Caution: Only adapters using Ralink RT3070/5370 chipsets are available. 

 Caution: WLAN cannot be used with Ethernet at the same time. 

1.5.7 Serial 

PBH-101 provides one serial port interfaced to D-SUB 9pin male connector and you can 

select the type of RS422, RS485 or RS232. Uploading PHPoC codes to your product is 

required to set the type of serial. 

 

Figure 1-4 serial 

 Please refer to the “PHPoC Device Programming Guide for P20” for detailed 

information about setting type of serial. 

 Serial Port Specification 

Parameter Value 

The number of port 1 

Serial Type RS232 / RS422 / RS485 

Baud rate 1,200 ~ 230,400 [bps] 

Parity NONE / EVEN / ODD / MARK / SPACE 

Data bit 8 or 7(7 data bit is only available on using Parity) 

Stop bit 1 or 2 

Flow control NONE, RTS/CTS 

Table 1-3 serial port specification 
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 RS232 pin assignment  

Pin Name Description Level I/O Note 

1 DCD Data Carrier Detect RS232 - N/A 

2 RXD Receive Data RS232 In basic 

3 TXD Transmit Data RS232 Out basic 

4 DTR 
Data Terminal Ready 

(always output active signal) 
RS232 Out optional 

5 GND Ground - - basic 

6 DSR Data Set Ready RS232 - N/A 

7 RTS Request To Send RS232 Out optional 

8 CTS Clear To Send RS232 In optional 

9 RI Ring Indicator RS232 - N/A 

Table 1-4 RS232 pin assignment 

 RS422 pin assignment 

Pin Name Description Level I/O Note 

9 TX + Transmit Data + RS422 Out basic 

1 TX - Transmit Data - RS422 Out basic 

4 RX + Receive Data + RS422 In basic 

3 RX - Receive Data - RS422 In basic 

5 GND Ground - - basic 

Table 1-5 RS422 pin assignment 

 RS485 pin assignment 

Pin Name Description Level I/O Note 

9 TRX + Data + RS485 In/Out basic 

1 TRX - Data - RS485 In/Out basic 

5 GND Ground - - basic 

Table 1-6 RS485 pin assignment 

 Biasing Register (100KΩ) is connected to RS422/485 line. 
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1.5.8 Ethernet 

PBH-101 has Ethernet port which supports 10/100M bit Ethernet. Both direct and cross 

over cable can be used because it automatically detects the type of cable. 

 LED of RJ45 Connector 

LED Operation State 

Green 

ON Connected to Network 

OFF Not connected to Network 

Blink Receiving or Transmitting Network Data 

Yellow 
ON Connected to 100M Ethernet 

OFF Connected to 10M Ethernet 

Table 1-7 LED of RJ45 connector 
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 Development Environment 

1.6.1 Overview 

PBH-101 provides development environment over USB. PHPoC Debugger, which is 

development software, is required to program to your product or to debug PHPoC source 

codes. 

 PHPoC Debugger 

1.7.1 Program Overview 

PHPoC Debugger is a software running on Windows. This program does not require 

installation. You can upload files to your product with this program through USB port. 

Features of PHPoC Debugger are as follows: 

 Upload files from local PC to PHPoC product 

 Save files which are in PHPoC product to local PC 

 Edit files stored in PHPoC product 

 Debug PHPoC scripts 

 Monitor PHPoC product resources 

 Set PHPoC product 

 Upgrade Firmware of PHPoC product 
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1.7.2 Program Structure 

 

Figure 1-5 program structure 

  

http://www.sollae.co.kr/


PBH-101 User Manual Ver. 1.1 

 

- 15 - http://www.eztcp.com 

 

① Menu bar 

Menu Sub menu Description 

File 

Open a poc file Open a poc format file 

Save selected file(s) Save selected files in file list to local PC 

Save a poc file Save all files in file list to local PC (.poc) 

Edit 

Undo Undo the latest job 

Redo Redo the latest job undone 

Cut Cut selected text and copy it to clip board 

Copy Copy selected text to clip board 

Paste Paste text of clip board 

Select all Select all text 

Find Find specified text 

Find Next Find the next text by down direction 

Find Previous Find the next text by up direction 

Change Replace specified text with given text 

Preferences Program preference 

Function 

Product / Firmware 

information 
Information of current firmware and product 

Network information Current network information 

View PHP error log View firmware log messages in error 

View firmware error log View firmware messages in error 

Upgrade firmware Upgrade firmware 

Reboot a product Reboot a product 

View firmware log view firmware log messages 

Firmware Debug mode Enable/disable Firmware debugging mode 

PHP Debug mode Enable/disable PHP debugging mode 

Font Change font 

Language Change language 

PHPoC Debugger 

information 
Information about PHPoC Debugger 

Table 1-8 menu bar  
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 Preferences 

Menu Sub menu Description 

View 

View margin Show / Hide margin 

View line number Show / Hide line number on margin  

View current line Enable / Disable current line emphasis 

Auto scroll Enable / Disable auto scroll 

Line ratio Set line space: 100, 120, 150, 200, 300 

Tab size Set tab size: 1, 2, 4, 8, 16 

Action of 

file add 

Internal editor PHPoC Debugger internal editor 

External editor External editor 

Ask Show select option every time 

Backup path Path of backup files 

Initialization 
Enter initialization 

mode 
Set product to initialization mode 

Table 1-9 preferences 

② COM PORT 

Part for choosing a virtual USB COM port 

③ Buttons 

Button Description 

 
Connect to PHPoC product 

 
Disconnect to PHPoC product 

 
Configure environmental values of PHPoC product 

 
Upload files on [File list] to PHPoC product 

 
Stop running PHPoC codes 

 
Run / Pause PHPoC codes 

 
Run line by line 

 
Run procedure by procedure 

Table 1-10 buttons 
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④ File list 

List of files in PHPoC product or to be uploaded to it 

Icon Description 

 Synchronized files 

 Files on PHPoC product before synchronization 

 Files on local PC before synchronization 

 Synchronized files on local PC for external editors 

Table 1-11 file list 

Following menus will be popped up when right clicking on file list area. 

Menu Description 

New Create a new php file 

Change the filename Modify file name 

Add Add files from local PC 

Delete Delete file on the list 

Table 1-12 pop up menu on file list 

⑤ Editor 

Show and edit contents of selected file on the file list. 

Following menus will be popped up when right clicking on editor area. 

Menu Description Shortcut 

Toggle Breakpoint Set / Unset break point on current line F9 

Remove All Breakpoints Unset all break points on current file Shift+F9 

Step Into Run line by line F11 

Step Over Run procedure by procedure F10 

Cut Cut selected codes and copy to clip board Ctrl+X 

Copy Copy selected codes to clip board Ctrl+C 

Paste Paste codes on clip board Ctrl+V 

Select all Select all codes Ctrl+A 

Table 1-13 pop up menu on editor 

⑥ Flash memory size 

This shows currently available or in-use space on flash memory of PHPoC product. 
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⑦ Output / FW Log 

This window is for displaying standard output and F/W log messages. 

The following menus will be popped up when right clicking on the windows. 

Menu Description 

Delete all logs Clear screen buffer 

Copy a log Copy selected log to clip board 

Auto scroll Set / Unset auto scroll 

Table 1-14 pop up menu on output / console window 

⑧ Watch / Resource 

This window is for checking run time variable information and system resources. 

The following menus will be popped up when right clicking on the watch window. 

Menu Description 

Add Add a variable 

Modify Modify a name of selected variable 

Delete Delete selected variables 

Delete all Delete all variables 

Detail Create a new window for detailed information 

Refresh Refresh variables 

Table 1-15 pop up menu on watch box 
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 2 Test Run 

This chapter instructs how to program and execute provided example codes. 

 Development Environment Construction 

2.1.1 Local PC 

A MS windows PC is required to upload php files to the PBH-101 while creating and 

modifying php files are available on other operating systems. 

2.1.2 Connecting PBH-101 

Connect PBH-101 to PC with a USB cable. 

2.1.3 Running PHPoC Debugger 

Run PHPoC Debugger on the PC. 

 This document defines "Upload" to "Sending files from a PC to PHPoC product." 

 

Figure 2-1 definition of upload  
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 Connecting Product 

2.2.1 Connecting Product 

Connect PBH-101 to a PC with a USB cable. 

 Device driver will be automatically installed when you connect PBH-101 to your PC. 

When automatic installation fails, download and install the driver on ST Micro's 

web site. 

 STM32 USB Virtual Com Port Driver Download page: 

http://www.st.com/web/catalog/tools/FM147/CL1794/SC961/SS1533/PF257938 

2.2.2 Ready to Communicate 

① Run PHPoC Debugger 

② Select connected COM PORT and press connect ( ) button. 

③ If USB is successfully connected, connect button will be inactivated and disconnect 

button ( ) will be activated.  
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 Practice 

2.3.1 PHPoC Operation 

PHPoC searches the "init.php" file right after it boots up. If there is no "init.php" file, 

none of PHPoC code will be implemented. Thus, you must create or upload the "init.php" 

file into PHPoC file system. 

You can write a script on the "init.php" as well as running other php files using php 

commands of system function. The "init.php" is implemented just once but loaded files by 

the command can be repeatedly run. 

 Please refer to the “PHPoC System Function” document for detailed information 

about system function. 

 Running script on "init.php" 

 

Figure 2-2 running script on "init.php" 

 Running another php file in "init.php" 

 

Figure 2-3 running another php file in "init.php" 
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 Script run flow chart 

 

Figure 2-4 flow chart of script run 

 "init.php" is start of all scripts. It means that every php file is directly or indirectly 

required to be loaded on "init.php" to run it. 

2.3.2 Default Files 

PBH-101 is released with the following files uploaded. 

File Name Description 

/lib/sd_101.php Basic library of PBH-101 

/lib/sn_tcp_ac.php TCP library 

/lib/sn_tcp_ws.php Web socket library 

/lib/sc_envs.php System ENV write library 

Table 2-1 default files 
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2.3.3 Create "init.php" 

 Click file list with the right button of your mouse and select [New] menu. 

 

Figure 2-5 create "init.php" (1) 

 Input "init" into the file name box. 

 

Figure 2-6 create "init.php" (2) 

 Select init.php file in the file list. 

 

Figure 2-7 select init.php  
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 Input the following command lines into the editor. 

 

Figure 2-8 Hello PHPoC (1) 

 Click upload button. ( ) 

 After PHPoC finishes uploading files, icon will be changed. (  → ) 

2.3.4 Excecute Script 

PHPoC automatically runs a script when it boots up or uploads file system. You can find 

the result in the Output window of PHPoC Debugger. 

 

Figure 2-9 result 

 If [PHP debug mode] option of PHPoC Debugger is enabled, PHPoC does 

not execute a script automatically. You can manually run the script by 

clicking the Run button. ( ) 

  

http://www.sollae.co.kr/


PBH-101 User Manual Ver. 1.1 

 

- 25 - http://www.eztcp.com 

 

 Saving Files to PC 

2.4.1 Saving File to PC 

 Select files in file list 

 

Figure 2-10 saving files to PC (1) 

 Click [File] > [Save selected file(s)]menu on menu bar  

 

Figure 2-11 saving files to PC (2) 

 Choose a path and click [OK] button. 

 

Figure 2-12 saving files to PC (3)  
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2.4.2 Save as a Integrated (.poc) file 

 When you want to save all files on the file list as a single file, use [Save a poc file] 

menu. 

 

Figure 2-13 save as a poc file (1) 

".poc" is filename extension. Input filename and click [Save] button. 

 

Figure 2-14 save as a poc file (2) 
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 Upload Files to Product 

PHP files in local PC can be uploaded to PHPoC products. 

2.5.1 How to Add Files to File list 

 Drag & Drop 

Select and drag files on Window explorer to file list box and drop them. 

 

Figure 2-15 add files to file list (1) 

 Add menu 

If you click [Add] after right-clicking in file list box, a window for selecting files will be 

created. Selected files on the windows will be added to the file list. 

 

Figure 2-16 add files to file list (2) 

 Integrated file(.poc) should be added by [File]>[Open a poc file] menu only 
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2.5.2 Upload files 

Files in the file list will be uploaded to product by clicking upload ( ) button. If the 

uploading is completed, both files on the file list and in the product are synchronized with 

changing ( ) icons 

 

Figure 2-17 upload files  
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 3 Management 

 Configure Parameters 

All parameters including an IP address can be configured by PHPoC Debugger. 

3.1.1 Configuration Procedure 

① Connect PHPoC product to PC. 

② Run PHPoC Debugger and click connect ( ) button. 

③ After then, click configuration ( ) button. 

 Sometimes you can see inactivated configuration button. In this case, click stop 

( ) button before configuration. 

④ Configure parameters 

 

Figure 3-1 configuration window  
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3.1.2 System Parameters 

Tab Category Parameter 

Network 

IPv4 

 

 

IP address 

Subnet mask 

Gateway IP address 

DNS server IP address 

IP address type - Use static IP address 

IP address type - Obtain an IP automatically (DHCP) 

IP address type - Obtain DNS server address automatically 

IPv6 (scheduled to support in the future) 

Wireless 

LAN 

Basic 

Settings 

WLAN - Enable / Disable 

WLAN Topology - Ad-hoc / Infrastructure / Soft AP 

Search AP / Search channel 

Channel 

SSID 

Internal Antenna / External Antenna 

Advanced Settings 

Security 

Settings 

Shared Key 

802.1X: EAP-TLS / EAP-TTLS / PEAP 

Buttons 

Password Password (ID: Admin) 

Certificate 

Write self-signed certificate 

Write signed certificate from certification authorities 

Read the certificate form a product 

Table 3-1 system parameters 

 Caution: PHPoC does not support restoration when you lose your password. You 

can restore your product to factory default condition by using level 2 initialization 

but all of your settings, files and the password will be deleted. 
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 Initialization 

3.2.1 Level 1 

Implementing level 1 initialization, both system parameters and user parameters 

including stored certificate will be initialized to factory state. However, password and file 

system will not be changed. 

 Level 1 Initialization Procedure 

Step Action Product State STS LED 

1 
Press function button shortly 

(less than 1 second) 
Button setup mode On 

2 
Keep pressing the function button 

over 5 seconds 
Preparing initialization 

Blink very 

rapidly 

3 Check STS LED after 5 seconds Initialization ready Off 

4 

After the step 3, release the 

function button within 2 seconds 

(After 2 seconds elapsed, state go 

back to the step 3) 

Progressing initialization On 

5 Rebooting automatically Initial state Off 

Table 3-2 level 1 initialization procedure 

 WLAN easy setup function will be activated in the button setup mode in level 1 

initialization. Thus, a STS LED can be blink if a wireless LAN client is linked. 

  

http://www.sollae.co.kr/


PBH-101 User Manual Ver. 1.1 

 

- 32 - http://www.eztcp.com 

 

3.2.2 Level 2 

When you implement level 2 initialization, all parameters including user password and file 

system is initialized to factory state. 

 Level 2 initialization should be used very carefully. Note that you had better to 

back up you files to a local PC before doing this because they will be deleted. 

 Level 2 Initialization Procedure 

Step Action Product State STS LED 

1 

Set PHPoC to initialization mode 

(Use [Edit]>[Preferences] menu on 

PHPoC Debugger) 

Enter Initialization mode 

after reboot 

Blink 

rapidly  

2 
Keep pressing the function button 

over 10 seconds 
Preparing initialization 

Blink very 

rapidly 

3 Check STS LED after 10 seconds Initialization ready Off 

4 

After the step 3, release the 

function button within 2 seconds 

(After 2 seconds elapsed, state go 

back to the step 3) 

Progressing initialization On 

5 Initialization is finished Initial state Off 

Table 3-3 level 2 initialization procedure  
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 WLAN Easy Setup 

Product enters into button setup mode when you push function button in normal state. 

In the mode, WLAN easy setup function is activated if an USB WLAN adapter is connected 

so you can access to your product by smartphone or laptop by WLAN. 

3.3.1 SSID 

Once WLAN easy setup function is activated in button setup mode, product uses SSID 

including own MAC address like an AP. SSID is contained the second half of the product's 

MAC address after "phpoc_" which is a prefix. For example, if the MAC address is 

"0030f9060101", the SSID is "phpoc_060101". 

3.3.2 WLAN Connection 

Find your product's SSID via a smartphone or laptop. 

 

Figure 3-2 WLAN connection 

3.3.3 DHCP 

While using WLAN easy setup function, a mobile automatically gets a dynamic IP address 

from your product. The IP address of your product is fixed to 192.168.0.1 and mobile 

obtains an IP address in 192.168.X.X range. 

3.3.4 Access to Product 

After uploading setting page to product, you can access to it by web browser. 

 

Figure 3-3 mobile connection (left: iOS, right: Android) 

 WLAN easy setup function is available on connecting a USB WLAN adapter. 
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 Web Interface 

PHPoC provides web interface regardless of script execution. TCP 80 is used for web 

interface and you can use the interface via Internet Explorer, Chrome or any other web 

browser. 

3.4.1 How to use web interface 

To use the web interface, "index.php" file should be in the file system of PBH-101. 

Connect to this page by entering device IP address after connecting it to network. 

 

Figure 3-4 web interface (1) 

If the name of file is not "index.php", just specify the name of file after the IP address 

with slash mark. 

 

Figure 3-5 web interface (2) 

3.4.2 Practical Use of Web Interface 

A web interface is very useful because it runs while PBH-101 is operating in button setup 

mode. If you upload web pages for running any function, you can easily use it by wireless 

LAN. 
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 Firmware Upgrade 

3.5.1 Download Firmware File 

Check and download firmware file on PHPoC web site to your local PC. 

3.5.2 Firmware Upgrade 

① Connect setup port of PHPoC product to local PC via USB cable. 

② Run PHPoC Debugger and click connect ( ) button. 

③ Click [Function] > [Upgrade Firmware] menu. 

 

Figure 3-6 firmware upgrade (1) 

④ Click [Open] button to select the firmware file. 

 

Figure 3-7 firmware upgrade (2) 

⑤ Click [Send] button. 

 

Figure 3-8 firmware upgrade (3) 

⑥ Firmware Upgrade Completed. 

 

Figure 3-9 firmware upgrade (4)  
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 Etcetera 

3.6.1 Using External Editor 

In case that you want to use not PHPoC Debugger's internal editor but external editor, 

just set [External editor] option of [action of file add] item on preferences window. 

 

Figure 3-10 using external editor (1) 

Upload php files with this option, synchronized files have lock icons as follows. Files with 

this icon cannot be modified by PHPoC Debugger's internal editor but external editors 

available. 

 

Figure 3-11 using external editor (2) 
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3.6.2 PHP Debug Mode 

PHPoC provides run-time debugging function. Buttons for debugging are enabled when 

you check the PHP debug mode option in PHPoC Debugger. In this mode, you can set 

break points or check values of variables at every command line. 

 

Figure 3-12 enable debug mode (1) 

When enabling debug mode, PHPoC pause running script at the first line. 

 

Figure 3-13 enable debug mode (2) 
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3.6.3 Escape Infinite Reboot Problem 

PHPoC basically runs scripts when it boots up. Therefore, it is possible that a PBH-101 

cannot be escape from infinite reboot by system command such as "reboot". To solve this 

problem, it is required to stop the running script. Refer to the following. 

① Entering ISP mode 

Make PBH-101 to enter ISP mode by supplying power while pressing FUNC button. In 

the ISP mode, you can access to PHPoC by PHPoC Debugger without running a script. 

② Connect to PHPoC 

Connect a PC to PHPoC via a USB cable and connect to the port via PHPoC Debugger. 

A message window related with ISP mode will be popped up. 

③ Reboot PHPoC 

Reboot PHPoC by using "Reboot a product" menu in PHPoC Debugger. After 

rebooting, PHPoC stops running script even it is not in the ISP mode. 

④ Correct source code 

Correct the source code to prevent infinite reboot state. 
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 4 Technical Support and Warranty 

 Technical Support  

Sollae Systems operates PHPoC forum web site. This forum is for solving problem, asking 

questions and sharing opinions among PHPoC users.  

 PHPoC Forum: http://www.phpoc.com/forum/ 

 Customer Support 

If you have any question regarding products, service and others, visit message board of 

Customer Support on Sollae Systems’ web site or send us an email: 

 Website Address for Customer Support: http://www.eztcp.com/en/support/ 

 E-mail: support@eztcp.com 

 Warranty 

4.3.1 Refund 

Upon the customer’s request to refund the product within two weeks after purchase, 

Sollae Systems will refund the product.  

4.3.2 Free Repair Services  

For product failures occurring within two years after purchase, Sollae Systems provides 

free repair services or exchange the product.  However, if the product failure is due to 

user’s fault, repair service fees will be charged or the product will be replaced at user’s 

expense.  

4.3.3 Charged Repair Services  

For product failures occurring after the warranty period (two years) or resulting from 

user’s fault, repair service fees will be charged and the product will be replaced at user’s 

expense. 
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 5 Precaution and Exemption from Liability 

 Precaution 

 Sollae Systems is not responsible for product failures occurring due to user’s 

alternation of the product.  

 Specifications of the product are subject to change without prior notice for 

performance improvement.  

 Sollae Systems does not guarantee successful operation of the product if the 

product was used under conditions deviating from the product specifications.  

 Reverse engineering of firmware and applications provided by Sollae Systems is 

prohibited.  

 Use of firmware and applications provided by Sollae Systems for purposes other 

than those for which they were designed is prohibited.  

 Do not use the product in an extremely cold or hot place or in a place where 

vibration is severe.  

 Do not use the product in an environment in which humidity is high or a lot of oil 

exists.  

 Do not use the product where there is caustic or combustible gas.  

 Sollae Systems does not guarantee normal operation of the product under the 

conditions a lot of noise exists.  

 Do not use the product for a purpose that requires exceptional quality and 

reliability relating to user’s injuries or accidents – aerospace, aviation, health care, 

nuclear power, transportation, and safety purposes.  

 Sollae Systems is not responsible for any accident or damage occurring while using 

the product.   
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 Exemption from Liability 

5.2.1  English version 

In no event shall Sollae Systems Co., Ltd. and its distributors be liable for any damages 

whatsoever (including, without limitation, damages for loss of profit, operating cost for 

commercial interruption, loss of information, or any other financial loss) from the use or 

inability to use the PBH-101 even if Sollae Systems Co., Ltd. and its distributors have been 

informed of such damages. 

The PBH-101 is not designed and not authorized for use in military applications, in 

nuclear applications, in airport applications, in applications involving explosives, in medical 

applications, in security alarm, in a fire alarm, in applications involving elevators, or in 

embedded applications in vehicles such as but not limited to cars, planes, trucks, boats, 

aircraft, helicopters, etc. 

In the same way, the PBH-101 is not designed, intended, authorized to test, develop, or 

be built into applications where failure could create a dangerous situation that may result 

in financial losses, damage to property, personal injury, or the death of people or animals. 

If you use the PBH-101 voluntarily or involuntarily for such unauthorized applications, you 

agree to subtract Sollae Systems Co., Ltd. and its distributors from all liability for any claim 

for compensation.  

Sollae Systems Co., Ltd. and its distributors entire liability and your exclusive remedy shall 

be Sollae Systems Co., Ltd. and its distributors option for the return of the price paid for, 

repair, or replacement of the PBH-101. 

In no event shall Sollae Systems Co., Ltd. and its distributors be liable for loss of user 

program codes which are stored in PBH-101. 

Sollae Systems Co., Ltd. and its distributors disclaim all other warranties, either expressed 

or implied, including, but not limited to, the implied warranties of merchantability and 

fitness for a particular purpose, with respect to the PBH-101 including accompanied written 

material, hardware and firmware. 
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5.2.2  French version 

 Documentation 

La documentation du boîtier PBH-101 est conçue avec la plus grande attention. Tous les 

efforts ont été mis en œuvre pour éviter les anomalies. Toutefois, nous ne pouvons garantir 

que cette documentation soit à 100% exempt de toute erreur. Les informations présentes 

dans cette documentation sont données à titre indicatif. Les caractéristiques techniques 

peuvent changer à tout moment sans aucun préavis dans le but d'améliorer la qualité et les 

possibilités des produits. 

 

 Copyright et appellations commerciales 

Toutes les marques, les procédés, les références et les appellations commerciales des 

produits cités dans la documentation appartiennent à leur propriétaire et Fabricant respectif. 

 

 Conditions d’utilisations et limite de responsabilité 

En aucun cas Sollae Systems Co., Ltd. ou un de ses distributeurs ne pourra être tenu 

responsable de dommages quels qu'ils soient (intégrant, mais sans limitation, les 

dommages pour perte de bénéfice commercial, interruption d'exploitation commerciale, 

perte d’informations et de données à caractère commercial ou de toute autre perte 

financière) provenant de l'utilisation ou de l'incapacité à pouvoir utiliser le boîtier PBH-101, 

même si Sollae Systems Co., Ltd. ou un de ses distributeurs a été informé de la possibilité 

de tels dommages. 

Le boîtier PBH-101 est exclusivement prévu pour un usage en intérieur, dans un 

environnement sec, tempéré (+10 °C à +40°C) et non poussiéreux. Le boîtier PBH-101 n’est 

pas prévu, ni autorisé pour être utilisé en extérieur, ni de façon embarquée dans des engins 

mobiles de quelque nature que ce soit (voiture, camion, train, avion, etc…), ni en milieu 

explosif, ni dans des enceintes nucléaires, ni dans des ascenseurs, ni dans des aéroports, ni 

dans des enceintes hospitaliers, ni pour des applications à caractère médical, ni dans des 

dispositifs de détection et d’alerte anti-intrusion, ni dans des dispositifs de détection et 

d’alerte anti-incendie, ni dans des dispositifs d’alarme GTC, ni pour des applications 

militaires. 

De même, le boîtier PBH-101 n’est pas conçu, ni destiné, ni autorisé pour expérimenter, 

développer ou être intégré au sein d’applications dans lesquelles une défaillance de celui-ci 

pourrait créer une situation dangereuse pouvant entraîner des pertes financières, des 

dégâts matériel, des blessures corporelles ou la mort de personnes ou d’animaux. Si vous 

utilisez le boîtier PBH-101 volontairement ou involontairement pour de telles applications 

non autorisées, vous vous engagez à soustraire Sollae Systems Co., Ltd. et ses distributeurs 

de toute responsabilité et de toute demande de dédommagement. 
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En cas de litige, l'entière responsabilité de Sollae Systems Co., Ltd. et de ses distributeurs 

vis-à-vis de votre recours durant la période de garantie se limitera exclusivement selon le 

choix de Sollae Systems Co., Ltd. et de ses distributeurs au remboursement de votre 

produit ou de sa réparation ou de son échange. Sollae Systems Co., Ltd. et ses distributeurs 

démentent toutes autres garanties, exprimées ou implicites. 

Tous les boîtiers PBH-101 sont testés avant expédition. Toute utilisation en dehors des 

spécifications et limites indiquées dans cette documentation ainsi que les court-circuit, les 

chocs, les utilisations non autorisées, pourront affecter la fiabilité, créer des 

dysfonctionnements et/ou la destruction du boîtier PBH-101 sans que la responsabilité de 

Sollae Systems Co., Ltd. et de ses distributeurs ne puissent être mise en cause, ni que le 

boîtier PBH-101 puisse être échangé au titre de la garantie. 

 

 Rappel sur l’évacuation des équipements électroniques usagés  

Le symbole de la poubelle barré présent sur le boîtier PBH-101 indique que vous ne 

pouvez pas vous débarrasser de ce dernier de la même façon que vos déchets courants.  

Au contraire, vous êtes responsable de  l’évacuation  du boîtier PBH-101 lorsqu’il arrive en  

fin de vie (ou qu’il est hors d’usage) et à cet effet,  vous êtes tenu de le remettre à un 

point de collecte agréé pour le recyclage des équipements électriques et électroniques 

usagés. Le tri, l’évacuation et le recyclage séparés de vos équipements usagés permettent 

de préserver les ressources naturelles et de s’assurer que ces équipements sont recyclés 

dans le respect de la santé humaine et de l’environnement. Pour plus d’informations sur les 

lieux de collecte des équipements électroniques usagés, contacter votre mairie ou votre 

service local de traitement des déchets. 
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 6 Appendix 

 Device Information 

6.1.1 Device overview 

Device Number Path Note 

UART 1 /mmap/uart0  

NET 2 /mmap/net0~1 0: wired, 1: wireless 

TCP 5 /mmap/tcp0~4  

UDP 5 /mmap/udp0~4  

I/O - Digital Output(LED) 8 /mmap/io3  

ST 4 /mmap/st0~3  

Table 6-1 device overview 

6.1.2 I/O port 

Type Path and Mapping information 

LED 

/mmap/io3 

 

UART Mode 

(Serial Type) 

/mmap/io4 

 

 Values for Serial Type 

Type Value SET RS485 SET 422 RE SET RS422 SET RS232 

RS232 0x05 0 1 0 1 

RS422 0x02 0 0 1 0 

RS485 0x0c 1 1 0 0 
 

Table 6-2 I/O port 

 Refer to the “Device Programming Guide for P20” for detailed information about 

using devices. 
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